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B402-1 
 

STUDENT OUTLINE 
 

PLAN CREATION AND DATABASE MAINTENANCE 
 
 

LEARNING OBJECTIVES: 
 
1.  Terminal Learning Objective:  Given a computer, Logistics 
Automated Information System (LOGAIS), a unit’s embarkation 
data, and the references, create a database in LOGAIS to ensure 
an accurate reflection of all unit assets are loaded for 
deployment per the reference.  (0431.01.05) 
 
2.  Enabling Learning Objectives: 
 

a.  Given a desktop computer, LOGAIS, a list of a unit’s 
equipment and supplies, and the reference, build a garrison 
database per the reference.  (0431.01.05a) 
 

b.  Given a desktop computer, LOGAIS, and a reference, use 
menu options to prepare a load plan per the references..  
(0431.01.05e) 
 

c.  Given a desktop computer, LOGAIS, and a list of unit’s 
equipment and supplies, and the reference, create a Unit 
Deployment List (UDL) using appropriate options and fields per 
the reference.  (0431.01.05f) 
 
OUTLINE 
 
1.  SYSTEM INITIALIZATION.  When you first open any program 
within LOGAIS, the system defaults to the last plan used and 
will open it when the system is initiated.  Even with a plan 
open, you can select, create, clone, delete, edit plan 
attributes or merge plans.  If you choose, you may close any 
active plan before using any of the file menu options available.  
Drop down menu options and icon descriptions are listed in 
student handout B402-2. 
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2.  CREATING A NEW PLAN.  The first thing that we are going to 
do is learn how to create a plan. 
 

STEP 1.  Select the File 
option (see Figure 1). 
 

STEP 2.  Select the New 
Plan option.  In the Plan Setup 
box, you are prompted to enter 
a Plan name, JOPES ID, 
classification, designate the 
plan as Real or an Exercise and 
Remarks.  (see Figure 2) 
 

STEP 3.  Enter “CAX 2 01” 
as the name for the plan.  The 
Plan Name can have up to eight 
characters.  
 

Figure 1. 
 

STEP 4.  The JOPES Plan ID is 
an identification number assigned 
for operational plans for specific 
areas of the world for a specicific 
contingency.  They are generally 
assigned by JOPES Planners at the 
Commander In Chief (CINC) level and 
not by embarkers.  Leave the JOPES 
Plan ID blank. 
 

STEP 5.  The classification 
denotes the security class of the 
plan that you are creating.  The 
arrow to the right allows you to select from Unclassified,
 Figure 2. 
Confidential, Secret, and Top  
Secret.  Type “U” to select Unclassified as the classification 
for this plan. 
 

STEP 6.  The next section amplifies the JOPES ID.  Here you 
select whether the plan is a real world contingency or an 
operational exercise.  Select “Exercise”. 
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STEP 7.  The Remarks field is available to include any 
remarks about the plan such as Rank and Name of the Marine who 
created it, or to identify a garrison plan.  Enter in your rank 
and last name.  Once the information has been entered, select 
“OK” and a new plan is initiated.  The plan is now the active 
plan. 
 
PRACTICAL APPLICATION 2-1. 
 
  Create the following plans using the above steps. 
 
Plan Name - CAX 3 01 Plan Name - CAX 4 01 
JOPES ID - LEAVE BLANK JOPES ID - LEAVE BLANK 
Classification - UNCLASSIFIED Classification - UNCLASSIFIED 
Select – Exercise Select - Exercise 
Remarks - LEAVE BLANK Remarks - LEAVE BLANK 
 
RESULTS:  The system will create the new plans.  Note at the top 
of the main window, “CAX 4 01” and the classification are 
displayed.  The LOGAIS system automatically sets the newly 
created plan as the current active plan.  Since this was the 
last plan created, it remains the active plan. 
 

3.  OPEN A PLAN.  This option allows 
you to select an existing plan to work 
on. 
 

STEP 1.  Select the Open Plan 
option from the File menu.  A list box 
of plans currently maintained in the 
database is displayed (see Figure 3). 
 

STEP 2.  Select “CAX 2 01” as the 
plan to Open.  “CAX 2 01” will now 
appear at the top of the main window 
along with the classification. 
 
STUDENT NOTE:  Once a plan is selected 
and opened, it becomes the default 
plan until a different one is  

Figure 3. selected.  This will be evident by the  
 name of the plan displayed at the top 
of the main window along with it's classification. 
 
4.  INTERFACES.  This option allows the user to import data from 
other LOGAIS systems or the former version of MDSSII. 
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STEP 1.  Select the INTERFACE option of the main menu and 
choose the IMPORT option.  An Import Options window appears. 
(see Figure 4.)  
 

STEP 2.  
Click on the 
DRIVE drop menu 
and select the 
A: drive. 
 
STEP 3.  Click 
on the INTERFACE 
TYPE and select 
LOGAIS (*.pex, 
*bak).  You 
should next 
receive a file 
in the box just 
below the file 
name box which 
is located on 
the “A:” drive. Figure 4. 
 

STEP 4.  Double click on the “MCSSS.pex” file, the file 
should next appear in the file name box. 
 

STEP 5.  Click on the “OK” button, the import process 
should begin. 
 

STEP 6.  The system will prompt you once the import is 
complete.  Click on the “OK” button.   
 

STEP 7.  Next, select the FILE OPEN menu and open the MCSSS 
plan.  That plan should now contain information within it. 
 
5.  SYSTEM DEFAULTS.  Each program within LOGAIS has a series of 
default settings that can be adjusted to fit the users needs.  
Fields can be moved, resized, or hidden from view as the user 
determines.  Some fields can be filled in automatically. 
 

a.  Moving Fields:  Fields can be moved by “clicking” on 
the field header at the top of each field and “dragging” to the 
desired location and “dropping”. 
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b.  Resizing Fields:  Fields can be resized by placing the 
mouse on the right side of 
the field so that it 
becomes a double pointed 
arrow (11 ).  Click and drag 
the field to the desired 
size. 
 

c.  Hidding Fields:  
Select WINDOW CUSTOMIZE 
VIEW option to acativate 
the Hidden Columns window  
(see Figure 5.)  Fields 
with a checkmark are 
visible in the current 
view.  UIC, NSN, and 
Package ID are required  

Figure 5. fields and cannot be  
 hidden. 
 

d.  Split Screen:  The screen can be split to 
allow the user to view two sides of the table at 
once.  With the UDL table maximized, move the mouse 
to the bottom left corner of the window so that it 
becomes a double pointed arrow (11 ) .  Click on the 
small black box, just left of the bottom scroll 
bar, (see Figure 6.) and drag to the desired 
location.   Figure 6. 
 

e.  Field Population:  Some fields can be filled in 
(populated) when a new record is inserted.  To set or change the 
default setting, select WINDOW PREFERENCES to open the 
Preferences window.  Select the UDL tab and type in or select 
the correct section code and/or UIC and choose “OK”. 
 
STUDENT NOTE:  Field size and locations are not saved if the 
program is closed.  Should you close out of MDSSII, the fields 
can be set back up the way you want them again.   
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PRACTICAL APPLICATION 5-1 
 
1.  Using the steps outlined above, move the Item ID field 
between UIC and NSN. 
 
2.  Using the steps outlined above, hide the ULN, TCN, and 
Landing Serial fields. 
 
3.  Using the steps outlined above, set the default setting for 
all newly inserted records to M22320. 
 
6.  INSERT/DELETE A RECORD.  These commands allow the user to 
add or delete records from the active database table. 
 

STEP 1.  To add a 
record select [Insert 
Record] from either the 
Edit menu or the Insert 
record Icon from the 
top line menu and a 
blank record is 
inserted. 
 

STEP 2.  Place the 
cursor in the NSN field 
by taking your mouse 
pointer and placing it 
into the NSN field and 
clicking the left mouse  Figure 7. 
button.  Perform a look up by using the [Look Up] command from 
the Edit menu, the ALT+F1 hot key, or the right mouse click 

option.  (see Figure 7.)  
 
STUDENT NOTE:  The system may ask 
you to choose what table you want 
to use to look up data.  (see 
Figure 8.)  You will always use 
the TechData table throughout 
this course in LOGAIS. 
 

STEP 3.  Place the cursor in 
the NSN field of the UDL Look Up  

Figure 8. table and select "Find".  Type  
 “2320” and then click “OK”.  The 
system will then search the database and locate the very first 
item listed with those digits we inserted into the find box. 



III-7 

STUDENT NOTE:  Experiment with the find option by looking up 
items also by ITEM ID (i.e. D1002 and D1059). 
 

STEP 4.  Once complete, select the “CANCEL” option to 
return to your UDL. 
 

STEP 5.  Place the cursor in the UIC field and type 
"M11111". 
 

STEP 6.  With the cursor in the Item ID field, select “Look 
Up”. 
 

STEP 7.  Select “Find” and type "D1158" in the find box. 
 

STEP 8.  To select the item, double click on the selected 
item or highlight it with mouse and select “OK”.  The item 
selection is based on the NSN Configuration that the user 
desires. 
 
STUDENT NOTE:  The NSN Configuration identifies the items 
dimensional configuration as far as its height, weight and 
length. 
 

STEP 9.  Place the cursor in the Serial Number field and 
type “123456”. 
 

STEP 10.  Place the cursor in the Package ID field.  Notice 
that the Package ID fills in automatically.  The Serial Number 
and Package ID fields are mandatory.  If you move the cursor up 
or down, the record will be posted or saved to the database, or 
you can select the Save menu from File option to post the 
record.  Select “Save”. Scroll to the right and look at the 
different columns of information for that record.  Notice those 
items that automatically updated when the record was chosen from 
the Techdata.  These fields do not always contain accurate 
information.  Ensure that you verify all entries for that actual 
item that you are inputting. 
 
STUDENT NOTE:  LOGAIS views an empty column in two very 
different ways depending on the field, either Null or Blank.  
The key required columns lick UIC, NSN, Package_ID and others 
are considered  NULL fields.  This means that once information 
is entered for that record in these fields it can never be blank 
again.  Most other fields may be blank after already containing 
information. 
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STEP 11.  Highlight the record you just created.  Select 
“Delete” from the Edit menu.  Delete the record before moving on 
to your next exercise.  The system prompts a Warning screen.  
Select “OK” to delete the record. 
 

STEP 12.  Press Ctrl + Insert together and type “M11111” in 
the UIC field.  In the ITEM ID field type "D1158" and press 
88 Enter.  All D1158's in the TechData file will be displayed.  You 
can select from the list the appropriate D1158s by highlighting 
the record with the appropriate NSN and configuration and 
selecting “OK”.  This function works for the NSN field also. 
 
7.  GENERATE RECORDS.  This command provides you with the 
ability to add multiple records quickly in the active table.  
The highlighted record is copied into the clipboard and cloned 
to your specified quantity. 
 

STEP 1.  Highlight the record with a PACKAGE ID of "123456" 
by clicking on it with the left mouse button. 
 

STEP 2.  Select the Generate 
Records command from the Edit menu.  
The Generate Records window is 
displayed prompting you to enter 
"HOW MANY" records.  (see Figure 9.) 
 

STEP 3.  Enter a Qty of five.  
You can enter a Qty of as many as 
you need.  Next select the “OK” 
button. Figure 9. 
 

STEP 4.  The system will prompt you that "five rows were 
inserted".  Select the OK button. 
 

STEP 5.  You now have five new records inserted with 
"generic" PACKAGE ID'S.  You now need to go back and enter into 
the Serial Number field the proper serial numbers.  Use serial 
numbers 123451 thru 123455. 
 
STUDENT NOTE:  Generated records will ALWAYS insert at the 
bottom of the UDL. 
 

STEP 6.  Once complete, delete the records you just 
generated. 
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PRACTICAL EXERCISE 7-1 ADDING RECORDS TO THE DATABASE: 
 
  Enter the following items of equipment into the UDL. 
 
  Remember to set the default for the UIC.  The UIC for all 
equipment will be "M11111". 
 
  Use the Copy, Cut and Paste menu options as much as possible. 
 
  Select the Generate Records option the from Edit menu to 
duplicate records where possible. 
 
  Ensure that the NSN’s and configurations in the look-up table 
match the gear represented below before you select the item. 
 
  Experiment with typing in the ITEM ID or NSN first and then 
selecting the correct equipment. 
 
  ALL fields below must be verified and updated. 
 
It is essential to enter the data accurately. 
 
UIC NSN SERIAL # NSN CONFIG TAMCN DESCRIPTION WT L W H JCSC

CC 
QTY UPTT U/I 

M11111 5820002237473 1232 OPERATIONAL A1815 RADIO SET 130 25 19 16 J3B 1 05 SE 

M11111 5820002237473 1245 OPERATIONAL A1815 RADIO SET 130 25 19 16 J3B 1 05 SE 

M11111 5820002237473 1254 OPERATIONAL A1815 RADIO SET 130 25 19 16 J3B 1 05 SE 

M11111 5820002237473 2565 OPERATIONAL A1815 RADIO SET 130 25 19 16 J3B 1 05 SE 

M11111 5820002237473 2587 OPERATIONAL A1815 RADIO SET 130 25 19 16 J3B 1 05 SE 

M11111 5820002237473 3221 OPERATIONAL A1815 RADIO SET 130 25 19 16 J3B 1 05 SE 

M11111 5820002237473 4452 OPERATIONAL A1815 RADIO SET 130 25 19 16 J3B 1 05 SE 

M11111 5820002237473 4585 OPERATIONAL A1815 RADIO SET 130 25 19 16 J3B 1 05 SE 

M11111 5820002237473 5625 OPERATIONAL A1815 RADIO SET 130 25 19 16 J3B 1 05 SE 

M11111 5820002237473 5626 OPERATIONAL A1815 RADIO SET 130 25 19 16 J3B 1 05 SE 

M11111 5820002237473 5666 OPERATIONAL A1815 RADIO SET 130 25 19 16 J3B 1 05 SE 

M11111 5820012347129 574223 OPERATIONAL A1935 RADIO SET 3040 132 71 74 R2D 1 22 EA 

M11111 5820012347129 574229 OPERATIONAL A1935 RADIO SET 3040 132 71 74 R2D 1 22 EA 

M11111 5820012347129 574663 OPERATIONAL A1935 RADIO SET 3040 132 71 74 R2D 1 22 EA 

M11111 5820012679482 RAD1 BOXED A2070 RADIO SET, 
MANPACK 

20 29 21 13 J3D 1 05 EA 

M11111 5820012679482 RAD10 BOXED A2070 RADIO SET, 
MANPACK 

20 29 21 13 J3D 1 05 EA 

M11111 5820012679482 RAD11 BOXED A2070 RADIO SET, 
MANPACK 

20 29 21 13 J3D 1 05 EA 

M11111 5820012679482 RAD12 BOXED A2070 RADIO SET, 
MANPACK 

20 29 21 13 J3D 1 05 EA 

M11111 5820012679482 RAD13 BOXED A2070 RADIO SET, 
MANPACK 

20 29 21 13 J3D 1 05 EA 

M11111 5820012679482 RAD14 BOXED A2070 RADIO SET, 
MANPACK 

20 29 21 13 J3D 1 05 EA 

M11111 5820012679482 RAD15 BOXED A2070 RADIO SET, 
MANPACK 

20 29 21 13 J3D 1 05 EA 
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UIC NSN SERIAL # NSN CONFIG TAMCN DESCRIPTION WT L W H JCSC
CC 

QTY UPTT U/I 

M11111 5820012679482 RAD16 BOXED A2070 RADIO SET, 
MANPACK 

20 29 21 13 J3D 1 05 EA 

M11111 5820012679482 RAD17 BOXED A2070 RADIO SET, 
MANPACK 

20 29 21 13 J3D 1 05 EA 

M11111 5820012679482 RAD18 BOXED A2070 RADIO SET, 
MANPACK 

20 29 21 13 J3D 1 05 EA 

M11111 5820012679482 RAD19 BOXED A2070 RADIO SET, 
MANPACK 

20 29 21 13 J3D 1 05 EA 

M11111 5820012679482 RAD2 BOXED A2070 RADIO SET, 
MANPACK 

20 29 21 13 J3D 1 05 EA 

M11111 5820012679482 RAD20 BOXED A2070 RADIO SET, 
MANPACK 

20 29 21 13 J3D 1 05 EA 

M11111 5820012679482 RAD21 BOXED A2070 RADIO SET, 
MANPACK 

20 29 21 13 J3D 1 05 EA 

M11111 5820012679482 RAD22 BOXED A2070 RADIO SET, 
MANPACK 

20 29 21 13 J3D 1 05 EA 

M11111 5820012679482 RAD23 BOXED A2070 RADIO SET, 
MANPACK 

20 29 21 13 J3D 1 05 EA 

M11111 5820012679482 RAD24 BOXED A2070 RADIO SET, 
MANPACK 

20 29 21 13 J3D 1 05 EA 

M11111 5820012679482 RAD25 BOXED A2070 RADIO SET, 
MANPACK 

20 29 21 13 J3D 1 05 EA 

M11111 5820012679482 RAD26 BOXED A2070 RADIO SET, 
MANPACK 

20 29 21 13 J3D 1 05 EA 

M11111 5820012679482 RAD27 BOXED A2070 RADIO SET, 
MANPACK 

20 29 21 13 J3D 1 05 EA 

M11111 5820012679482 RAD28 BOXED A2070 RADIO SET, 
MANPACK 

20 29 21 13 J3D 1 05 EA 

M11111 5820012679482 RAD29 BOXED A2070 RADIO SET, 
MANPACK 

20 29 21 13 J3D 1 05 EA 

M11111 5820012679482 RAD3 BOXED A2070 RADIO SET, 
MANPACK 

20 29 21 13 J3D 1 05 EA 

M11111 5820012679482 RAD30 BOXED A2070 RADIO SET, 
MANPACK 

20 29 21 13 J3D 1 05 EA 

M11111 5820012679482 RAD31 BOXED A2070 RADIO SET, 
MANPACK 

20 29 21 13 J3D 1 05 EA 

M11111 5820012679482 RAD32 BOXED A2070 RADIO SET, 
MANPACK 

20 29 21 13 J3D 1 05 EA 

M11111 5820012679482 RAD33 BOXED A2070 RADIO SET, 
MANPACK 

20 29 21 13 J3D 1 05 EA 

M11111 5820012679482 RAD34 BOXED A2070 RADIO SET, 
MANPACK 

20 29 21 13 J3D 1 05 EA 

M11111 5820012679482 RAD35 BOXED A2070 RADIO SET, 
MANPACK 

20 29 21 13 J3D 1 05 EA 

M11111 5820012679482 RAD36 BOXED A2070 RADIO SET, 
MANPACK 

20 29 21 13 J3D 1 05 EA 

M11111 5820012679482 RAD37 BOXED A2070 RADIO SET, 
MANPACK 

20 29 21 13 J3D 1 05 EA 

M11111 5820012679482 RAD38 BOXED A2070 RADIO SET, 
MANPACK 

20 29 21 13 J3D 1 05 EA 

M11111 5820012679482 RAD39 BOXED A2070 RADIO SET, 
MANPACK 

20 29 21 13 J3D 1 05 EA 

M11111 5820012679482 RAD4 BOXED A2070 RADIO SET, 
MANPACK 

20 29 21 13 J3D 1 05 EA 

M11111 5820012679482 RAD40 BOXED A2070 RADIO SET, 
MANPACK 

20 29 21 13 J3D 1 05 EA 

M11111 5820012679482 RAD41 BOXED A2070 RADIO SET, 
MANPACK 

20 29 21 13 J3D 1 05 EA 

M11111 5820012679482 RAD42 BOXED A2070 RADIO SET, 
MANPACK 

20 29 21 13 J3D 1 05 EA 

M11111 5820012679482 RAD43 BOXED A2070 RADIO SET, 
MANPACK 

20 29 21 13 J3D 1 05 EA 

M11111 5820012679482 RAD44 BOXED A2070 RADIO SET, 
MANPACK 

20 29 21 13 J3D 1 05 EA 

M11111 5820012679482 RAD45 BOXED A2070 RADIO SET, 
MANPACK 

20 29 21 13 J3D 1 05 EA 
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UIC NSN SERIAL # NSN CONFIG TAMCN DESCRIPTION WT L W H JCSC
CC 

QTY UPTT U/I 

M11111 5820012679482 RAD46 BOXED A2070 RADIO SET, 
MANPACK 

20 29 21 13 J3D 1 05 EA 

M11111 5820012679482 RAD47 BOXED A2070 RADIO SET, 
MANPACK 

20 29 21 13 J3D 1 05 EA 

M11111 5820012679482 RAD48 BOXED A2070 RADIO SET, 
MANPACK 

20 29 21 13 J3D 1 05 EA 

M11111 5820012679482 RAD49 BOXED A2070 RADIO SET, 
MANPACK 

20 29 21 13 J3D 1 05 EA 

M11111 5820012679482 RAD5 BOXED A2070 RADIO SET, 
MANPACK 

20 29 21 13 J3D 1 05 EA 

M11111 5820012679482 RAD50 BOXED A2070 RADIO SET, 
MANPACK 

20 29 21 13 J3D 1 05 EA 

M11111 5820012679482 RAD51 BOXED A2070 RADIO SET, 
MANPACK 

20 29 21 13 J3D 1 05 EA 

M11111 5820012679482 RAD52 BOXED A2070 RADIO SET, 
MANPACK 

20 29 21 13 J3D 1 05 EA 

M11111 5820012679482 RAD53 BOXED A2070 RADIO SET, 
MANPACK 

20 29 21 13 J3D 1 05 EA 

M11111 5820012679482 RAD54 BOXED A2070 RADIO SET, 
MANPACK 

20 29 21 13 J3D 1 05 EA 

M11111 5820012679482 RAD55 BOXED A2070 RADIO SET, 
MANPACK 

20 29 21 13 J3D 1 05 EA 

M11111 5820012679482 RAD56 BOXED A2070 RADIO SET, 
MANPACK 

20 29 21 13 J3D 1 05 EA 

M11111 5820012679482 RAD57 BOXED A2070 RADIO SET, 
MANPACK 

20 29 21 13 J3D 1 05 EA 

M11111 5820012679482 RAD58 BOXED A2070 RADIO SET, 
MANPACK 

20 29 21 13 J3D 1 05 EA 

M11111 5820012679482 RAD6 BOXED A2070 RADIO SET, 
MANPACK 

20 29 21 13 J3D 1 05 EA 

M11111 5820012679482 RAD7 BOXED A2070 RADIO SET, 
MANPACK 

20 29 21 13 J3D 1 05 EA 

M11111 5820012679482 RAD8 BOXED A2070 RADIO SET, 
MANPACK 

20 29 21 13 J3D 1 05 EA 

M11111 5820012679482 RAD9 BOXED A2070 RADIO SET, 
MANPACK 

20 29 21 13 J3D 1 05 EA 

M11111 8415013337573 SUIT21 OPERATIONAL C2300 SUIT, PROTECTIVE, 
CHEMICAL 
(OVERGARMENT) 

5 11 12 8 J3D 1 05 EA 

M11111 8415013337573 SUIT22 OPERATIONAL C2300 SUIT, PROTECTIVE, 
CHEMICAL 
(OVERGARMENT) 

5 11 12 8 J3D 1 05 EA 

M11111 8415013337573 SUIT23 OPERATIONAL C2300 SUIT, PROTECTIVE, 
CHEMICAL 
(OVERGARMENT) 

5 11 12 8 J3D 1 05 EA 

M11111 8415013337573 SUIT24 OPERATIONAL C2300 SUIT, PROTECTIVE, 
CHEMICAL 
(OVERGARMENT) 

5 11 12 8 J3D 1 05 EA 

M11111 8415013337573 SUIT25 OPERATIONAL C2300 SUIT, PROTECTIVE, 
CHEMICAL 
(OVERGARMENT) 

5 11 12 8 J3D 1 05 EA 

M11111 8415013337573 SUIT26 OPERATIONAL C2300 SUIT, PROTECTIVE, 
CHEMICAL 
(OVERGARMENT) 

5 11 12 8 J3D 1 05 EA 

M11111 8415013337573 SUIT27 OPERATIONAL C2300 SUIT, PROTECTIVE, 
CHEMICAL 
(OVERGARMENT) 

5 11 12 8 J3D 1 05 EA 

M11111 8415013337573 SUIT28 OPERATIONAL C2300 SUIT, PROTECTIVE, 
CHEMICAL 
(OVERGARMENT) 

5 11 12 8 J3D 1 05 EA 

M11111 8415013337573 SUIT29 OPERATIONAL C2300 SUIT, PROTECTIVE, 
CHEMICAL 
(OVERGARMENT) 

5 11 12 8 J3D 1 05 EA 

M11111 8415013337573 SUIT30 OPERATIONAL C2300 SUIT, PROTECTIVE, 
CHEMICAL 
(OVERGARMENT) 

5 11 12 8 J3D 1 05 EA 
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UIC NSN SERIAL # CONFIG TAMCN DESCRIPTION WT L W H JCSC
CC 

QTY UPTT U/I 

M11111 8415013337573 SUIT31 OPERATIONAL C2300 SUIT, PROTECTIVE, 
CHEMICAL 
(OVERGARMENT) 

5 11 12 8 J3D 1 05 EA 

M11111 8415013337573 SUIT32 OPERATIONAL C2300 SUIT, PROTECTIVE, 
CHEMICAL 
(OVERGARMENT) 

5 11 12 8 J3D 1 05 EA 

M11111 8415013337573 SUIT33 OPERATIONAL C2300 SUIT, PROTECTIVE, 
CHEMICAL 
(OVERGARMENT) 

5 11 12 8 J3D 1 05 EA 

M11111 8415013337573 SUIT34 OPERATIONAL C2300 SUIT, PROTECTIVE, 
CHEMICAL 
(OVERGARMENT) 

5 11 12 8 J3D 1 05 EA 

M11111 8415013337573 SUIT35 OPERATIONAL C2300 SUIT, PROTECTIVE, 
CHEMICAL 
(OVERGARMENT) 

5 11 12 8 J3D 1 05 EA 

M11111 8415013337573 SUIT36 OPERATIONAL C2300 SUIT, PROTECTIVE, 
CHEMICAL 
(OVERGARMENT) 

5 11 12 8 J3D 1 05 EA 

M11111 8415013337573 SUIT37 OPERATIONAL C2300 SUIT, PROTECTIVE, 
CHEMICAL 
(OVERGARMENT) 

5 11 12 8 J3D 1 05 EA 

M11111 8415013337573 SUIT38 OPERATIONAL C2300 SUIT, PROTECTIVE, 
CHEMICAL 
(OVERGARMENT) 

5 11 12 8 J3D 1 05 EA 

M11111 8415013337573 SUIT39 OPERATIONAL C2300 SUIT, PROTECTIVE, 
CHEMICAL 
(OVERGARMENT) 

5 11 12 8 J3D 1 05 EA 

M11111 8415013337573 SUIT40 OPERATIONAL C2300 SUIT, PROTECTIVE, 
CHEMICAL 
(OVERGARMENT) 

5 11 12 8 J3D 1 05 EA 

M11111 8465012535335 PAK1 OPERATIONAL C3337 PACK, FLD, MEDIUM 7 24 24 2 J3D 1 05 EA 

M11111 8465012535335 PAK10 OPERATIONAL C3337 PACK, FLD, MEDIUM 7 24 24 2 J3D 1 05 EA 

M11111 8465012535335 PAK11 OPERATIONAL C3337 PACK, FLD, MEDIUM 7 24 24 2 J3D 1 05 EA 

M11111 8465012535335 PAK12 OPERATIONAL C3337 PACK, FLD, MEDIUM 7 24 24 2 J3D 1 05 EA 

M11111 8465012535335 PAK13 OPERATIONAL C3337 PACK, FLD, MEDIUM 7 24 24 2 J3D 1 05 EA 

M11111 8465012535335 PAK14 OPERATIONAL C3337 PACK, FLD, MEDIUM 7 24 24 2 J3D 1 05 EA 

M11111 8465012535335 PAK15 OPERATIONAL C3337 PACK, FLD, MEDIUM 7 24 24 2 J3D 1 05 EA 

M11111 8465012535335 PAK2 OPERATIONAL C3337 PACK, FLD, MEDIUM 7 24 24 2 J3D 1 05 EA 

M11111 8465012535335 PAK3 OPERATIONAL C3337 PACK, FLD, MEDIUM 7 24 24 2 J3D 1 05 EA 

M11111 8465012535335 PAK4 OPERATIONAL C3337 PACK, FLD, MEDIUM 7 24 24 2 J3D 1 05 EA 

M11111 8465012535335 PAK5 OPERATIONAL C3337 PACK, FLD, MEDIUM 7 24 24 2 J3D 1 05 EA 

M11111 8465012535335 PAK6 OPERATIONAL C3337 PACK, FLD, MEDIUM 7 24 24 2 J3D 1 05 EA 

M11111 8465012535335 PAK7 OPERATIONAL C3337 PACK, FLD, MEDIUM 7 24 24 2 J3D 1 05 EA 

M11111 8465012535335 PAK8 OPERATIONAL C3337 PACK, FLD, MEDIUM 7 24 24 2 J3D 1 05 EA 

M11111 8465012535335 PAK9 OPERATIONAL C3337 PACK, FLD, MEDIUM 7 24 24 2 J3D 1 05 EA 

M11111 2310011467194 556228 OPERATIONAL D1002 TRK AMB, 2 
LITTER, SOFT TOP, 
1 1/4 TON HMMWV 

4960 180 85 73 R2D 1 22 EA 

M11111 2310011467194 667262 OPERATIONAL D1002 TRK AMB, 2 
LITTER, SOFT TOP, 
1 1/4 TON HMMWV 

4960 180 85 73 R2D 1 22 EA 

M11111 2320011077155 412364 OPERATIONAL D1158 TRK, UTILITY, 
CARGO TRP CARR 1 
1/4 TON W/EQUIP, 
HM 

5280 182 87 74 R2D 1 22 EA 

M11111 2320011077155 443536 OPERATIONAL D1158 TRK, UTILITY, 
CARGO TRP CARR 1 
1/4 TON W/EQUIP, 
HM 

5280 182 87 74 R2D 1 22 EA 
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UIC NSN SERIAL # NSN CONFIG TAMCN DESCRIPTION WT L W H JCSC
CC 

QTY UPTT U/I 

M11111 2320011077155 552178 OPERATIONAL D1158 TRK, UTILITY, 
CARGO TRP CARR 1 
1/4 TON W/EQUIP, 
HM 

5280 182 87 74 R2D 1 22 EA 

M11111 2320011077155 564562 OPERATIONAL D1158 TRK, UTILITY, 
CARGO TRP CARR 1 
1/4 TON W/EQUIP, 
HM 

5280 182 87 74 R2D 1 22 EA 

M11111 2320011467189 694581 OPERATIONAL D1159 TRK, UTIL, ARMT 
CARR, W/SA, 
1 1/4T, W/WINCH 
HMMWV 

6360 186 85 75 R2D 1 22 EA 

M11111 2320011467189 749658 OPERATIONAL D1159 TRK, UTIL, ARMT 
CARR, W/SA, 
1 1/4T, W/WINCH 
HMMWV 

6360 186 85 75 R2D 1 22 EA 

M11111 2320011467189 857588 OPERATIONAL D1159 TRK, UTIL, ARMT 
CARR, W/SA, 
1 1/4T, W/WINCH 
HMMWV 

6360 186 85 75 R2D 1 22 EA 

M11111 1005011289936 00623222 OPERATIONAL E1441 RIFLE (IMPROVED), 
5.56MM 

8 40 3 9 J3A 1 05 EA 

M11111 1005011289936 00624221 OPERATIONAL E1441 RIFLE (IMPROVED), 
5.56MM 

8 40 3 9 J3A 1 05 EA 

M11111 1005011289936 12021615 OPERATIONAL E1441 RIFLE (IMPROVED), 
5.56MM 

8 40 3 9 J3A 1 05 EA 

M11111 1005011289936 12314568 OPERATIONAL E1441 RIFLE (IMPROVED), 
5.56MM 

8 40 3 9 J3A 1 05 EA 

M11111 1005011289936 12602312 OPERATIONAL E1441 RIFLE (IMPROVED), 
5.56MM 

8 40 3 9 J3A 1 05 EA 

M11111 1005011289936 12612313 OPERATIONAL E1441 RIFLE (IMPROVED), 
5.56MM 

8 40 3 9 J3A 1 05 EA 

M11111 1005011289936 16131215 OPERATIONAL E1441 RIFLE (IMPROVED), 
5.56MM 

8 40 3 9 J3A 1 05 EA 

M11111 1005011289936 16516151 OPERATIONAL E1441 RIFLE (IMPROVED), 
5.56MM 

8 40 3 9 J3A 1 05 EA 

M11111 1005011289936 21315656 OPERATIONAL E1441 RIFLE (IMPROVED), 
5.56MM 

8 40 3 9 J3A 1 05 EA 

M11111 1005011289936 31235549 OPERATIONAL E1441 RIFLE (IMPROVED), 
5.56MM 

8 40 3 9 J3A 1 05 EA 

M11111 1005011289936 32051615 OPERATIONAL E1441 RIFLE (IMPROVED), 
5.56MM 

8 40 3 9 J3A 1 05 EA 

M11111 1005011289936 32123545 OPERATIONAL E1441 RIFLE (IMPROVED), 
5.56MM 

8 40 3 9 J3A 1 05 EA 

M11111 1005011289936 33244555 OPERATIONAL E1441 RIFLE (IMPROVED), 
5.56MM 

8 40 3 9 J3A 1 05 EA 

M11111 1005011289936 41561265 OPERATIONAL E1441 RIFLE (IMPROVED), 
5.56MM 

8 40 3 9 J3A 1 05 EA 

M11111 1005011289936 42312335 OPERATIONAL E1441 RIFLE (IMPROVED), 
5.56MM 

8 40 3 9 J3A 1 05 EA 

M11111 1005011289936 44553123 OPERATIONAL E1441 RIFLE (IMPROVED), 
5.56MM 

8 40 3 9 J3A 1 05 EA 

M11111 1005011289936 45602315 OPERATIONAL E1441 RIFLE (IMPROVED), 
5.56MM 

8 40 3 9 J3A 1 05 EA 

M11111 1005011289936 45612316 OPERATIONAL E1441 RIFLE (IMPROVED), 
5.56MM 

8 40 3 9 J3A 1 05 EA 

M11111 1005011289936 45613212 OPERATIONAL E1441 RIFLE (IMPROVED), 
5.56MM 

8 40 3 9 J3A 1 05 EA 

M11111 1005011289936 45645642 OPERATIONAL E1441 RIFLE (IMPROVED), 
5.56MM 

8 40 3 9 J3A 1 05 EA 

M11111 1005011289936 45674764 OPERATIONAL E1441 RIFLE (IMPROVED), 
5.56MM 

8 40 3 9 J3A 1 05 EA 

M11111 1005011289936 46513155 OPERATIONAL E1441 RIFLE (IMPROVED), 
5.56MM 

8 40 3 9 J3A 1 05 EA 

M11111 1005011289936 54105255 OPERATIONAL E1441 RIFLE (IMPROVED), 
5.56MM 

8 40 3 9 J3A 1 05 EA 
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UIC NSN SERIAL # NSN CONFIG TAMCN DESCRIPTION WT L W H JCSC
CC 

QTY UPTT U/I 

M11111 1005011289936 54151651 OPERATIONAL E1441 RIFLE (IMPROVED), 
5.56MM 

8 40 3 9 J3A 1 05 EA 

M11111 1005011289936 54560223 OPERATIONAL E1441 RIFLE (IMPROVED), 
5.56MM 

8 40 3 9 J3A 1 05 EA 

M11111 1005011289936 54561633 OPERATIONAL E1441 RIFLE (IMPROVED), 
5.56MM 

8 40 3 9 J3A 1 05 EA 

M11111 1005011289936 54565412 OPERATIONAL E1441 RIFLE (IMPROVED), 
5.56MM 

8 40 3 9 J3A 1 05 EA 

M11111 1005011289936 54613456 OPERATIONAL E1441 RIFLE (IMPROVED), 
5.56MM 

8 40 3 9 J3A 1 05 EA 

M11111 1005011289936 54645154 OPERATIONAL E1441 RIFLE (IMPROVED), 
5.56MM 

8 40 3 9 J3A 1 05 EA 

M11111 1005011289936 54651566 OPERATIONAL E1441 RIFLE (IMPROVED), 
5.56MM 

8 40 3 9 J3A 1 05 EA 

M11111 1005011289936 54665445 OPERATIONAL E1441 RIFLE (IMPROVED), 
5.56MM 

8 40 3 9 J3A 1 05 EA 

M11111 1005011289936 54678125 OPERATIONAL E1441 RIFLE (IMPROVED), 
5.56MM 

8 40 3 9 J3A 1 05 EA 

M11111 1005011289936 56412232 OPERATIONAL E1441 RIFLE (IMPROVED), 
5.56MM 

8 40 3 9 J3A 1 05 EA 

M11111 1005011289936 56415155 OPERATIONAL E1441 RIFLE (IMPROVED), 
5.56MM 

8 40 3 9 J3A 1 05 EA 

M11111 1005011289936 56511651 OPERATIONAL E1441 RIFLE (IMPROVED), 
5.56MM 

8 40 3 9 J3A 1 05 EA 

M11111 1005011289936 61561322 OPERATIONAL E1441 RIFLE (IMPROVED), 
5.56MM 

8 40 3 9 J3A 1 05 EA 

M11111 1005011289936 65110561 OPERATIONAL E1441 RIFLE (IMPROVED), 
5.56MM 

8 40 3 9 J3A 1 05 EA 

M11111 1005011289936 65561011 OPERATIONAL E1441 RIFLE (IMPROVED), 
5.56MM 

8 40 3 9 J3A 1 05 EA 

M11111 1005011289936 84561122 OPERATIONAL E1441 RIFLE (IMPROVED), 
5.56MM 

8 40 3 9 J3A 1 05 EA 

M11111 1005011289936 84564541 OPERATIONAL E1441 RIFLE (IMPROVED), 
5.56MM 

8 40 3 9 J3A 1 05 EA 

M11111 1005011289936 89451516 OPERATIONAL E1441 RIFLE (IMPROVED), 
5.56MM 

8 40 3 9 J3A 1 05 EA 
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8.  ROSTER TABLE.  While the Unit Deployment List (UDL) is used 
to maintain charactoristic data for unit equipment assets, the 

roster table allows the user to 
insert personnel within their unit.  
These personnel are identified by 
Name, Rank, SSN and many other 
descriptions. 
 

STEP 1.  To enter another table 
within the same plan, select the User 
Plan Data menu option.  Here all the 
tables available to the current plan 
are listed.  Select Roster table from 
the Plan Management window (see 
Figure 10.).  Press Insert to enter a 
new record.   
 

STEP 2.  In the Social Security 
Nr field, type your SSN and press 
TAB. 
 

Figure 10. STEP 3.  In the Last Name field  
 type your last name. 
 

STEP 4.  Move to the T/O Number field and press ALT & F1 
keys to activate the lookup function.  In the lookup table, move 
the cursor into the T/O Number field and click “Find” to 
activate the search function.  Type “1013G” and press 88 ENTER to 
start the search. What is the T/O Line Number of the record the 
system found? 
 

STEP 5.  Move the cursor down to the record with T/O Line 
Number 0002.  Click “OK” to select the record.  
 

STEP 6.  Notice that the Roster table is updated with the 
search information. 
 

STEP 7.  In the UIC field type “M11111”. 
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PRACTICAL EXERCISE 8-1 ENTERING RECORDS INTO ROSTER TABLE: 
 

STEP 1.  Now, let's try another record.  Press Ctrl & INS 
keys and move to the Social Security Nr field and type 
“100202222”. 
 

STEP 2.  Move to the Last Name field of the same record and 
type your last name.   
 

STEP 3.  Move to the T/O Number field and press Alt & F1 to 
activate the lookup. 
 

STEP 4.  Move the cursor into the T/O Number field of the 
Roster table and press “Find” to repeat the previous search 
(1013G).  Move down to the record with T/O Line Number "15" and 
Click “OK” to select the record. 
 

STEP 5.  Notice the other fields that are filled in from 
this lookup when you move the cursor off the T/O Number field. 
 
PRACTICAL EXERCISE 8-2 
 

STEP 1.  Use the procedures above and the data provided 
below, to complete the sample Roster. 
 
SSN        LAST NAME FIRST NAME  T/O    LINE #   UIC      RANK 
 
321654987  PULLER    CHESTY      1013G  0017     M11111   CPL 
417852369  DALEY     DAN         1013G  0018     M11111   LCPL 
546987123  BASILON   JOHN        8990   0002     M11110   COL 
693258741  COX       ARCHIBALD   8990   0003     M11110   LTCOL  
 

STEP 2.  Close the Roster table.  Select Retrive from the 
Edit Menu. 
 
9.  Copy plan.  This option allows you to create a new plan 
using an existing plan.  You will be prompted to select an 
existing plan to Copy.  Next you will name the new plan.  Once 
this is done a new plan will be initiated and will be an exact 
copy of the existing plan.  This allows you to easily make minor 
variations on a plan and not effect another. 
 

STEP 1.  Select Copy Plan from the File menu.  You will see 
a list box which lists plans currently maintained in the 
database. (see Figure 11.) 
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STEP 2.  Select “MCSSS” as the plan to copy.  Select “OK”.  
You will be prompted to enter the new Plan Name. 
 

STEP 3.  Enter “CAX 5 01” for 
the Plan Name. 
 

STEP 4.  You will be asked if 
you want to copy the plan selected to 
the new Plan Name you entered.  
 

STEP 5.  Select OK. 
 
STUDENT NOTE:  Once the copying has 
been completed, the system will 
return you to the main work area with 
the newly created plan.  Once again, 
the purpose of Copy Plan is to create 
a new plan using an existing plan.  
This saves you time, so that you do 
not have to create an entire new 
plan. Figure 11. 
 

10.  PLAN SETUP.  This option 
allows you to select an 
existing plan and edit its 
Plan Attributes (e.g., plan 
classification and remarks) 
(see Figure 12.) 
 

STEP 1.  Select Plan 
Setup from the File menu 
option. 
 

STEP 2.  Keep the 
classification 
“Unclassified”. 
 

STEP 3.  Move to the 
Remarks field. 
 

STEP 4.  Type "OPLAN 
XXXX" in the remarks field  

Figure 12. and select “OK”. 
 
11.  MERGE PLANS.  This option allows you to take a separate 
plan and combine it with the current active plan. 
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STEP 1.  Select Merge Plans from the File menu option. 
 

STEP 2.  You will be presented with a list box of plans 
currently in the database.  Select CAX 4 01 and select “OK”. 
 

STEP 3.  You will be asked if it is OK to merge the 
selected plan into the current plan.  Select “OK” to continue. 
 
12.  DELETE PLAN.  This option allows you to remove obsolete 
plans from the LOGAIS system. 
 

STEP 1.  Select Delete Plan from the File menu option.  A 
list box appears so you can select a plan to delete.  After 
selecting a plan to delete, you will see a message box asking 
you if you want to continue.  This gives you a final opportunity 
to quit the deletion process by selecting “Cancel”. 
 

STEP 2.  Select “OK” to continue with the delete process. 
 

STEP 3.  Delete the following plans. 
 

Plan Name - “CAX 2 01” 
Plan Name - “CAX 3 01” 
Plan Name - “CAX 4 01” 

 
STUDENT NOTE:  Ensure you do not delete the following plans: 
 
 CAX 5 01 MCSSS MPS FIE PREPO Standard MEF 
 
REFERENCES: 
 
1.  LOGAIS 6.0 Help File 


